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New In This Release

New In This Release

This section contains a brief description of new features in Genesys Workforce Management (WFM)
8.1.x releases.
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New in 8.1.2

Effective Date for Contracts

Users can specify an effective start date for a Contract and assign agents to the
contract accordingly. The agent can have multiple assigned Contracts, but each
one must have a different effective date. [+]

See the Web for Supervisors Help topics:

e Configuration > Agents > Contracts and Rotating Patterns

e Policies > Contracts > Agents

Effective Date for Rotating Patterns

Users can specify an effective start date for a Rotating Pattern, which is the date
that the Rotating Pattern becomes effective for the agent. The agent can have
multiple assigned Rotating Patterns, but each one must have a different effective
date. [+]

See the Web for Supervisors Help topics:

e Configuration > Agents > Contracts and Rotating Patterns.

e Policies > Rotating Patterns > Associated Agents

Effective Date for Activities

Users can specify an effective date for activities, which is the start date that the
agent becomes eligible to work on the activity. [+1]

See the Web for Supervisors Help topic Configuration > Agents > Activities.
Automated Time Off Carry Over

Users can set the calculation of Time Off Carry-Over to occur automatically. [+]

See the Configuration Utility help topic Policies > Time Off Rules > Carry-
Over Rules section.
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View Web Agent Schedule on Mobile Devices

Agents can log in to WFM Web and view their schedule on their iPhone 4, i0OS 5
mobile device. [+]

See the Web for Agents Help topic Getting Started > Overview. or the
Supervisor help topic Getting Started > Overview.

Contact Center Performance Report Enhancement

Users can now view forecast-related data in the Contact Center Performance
Report and Contact Center Performance Graph Report. [+]

See the Web for Supervisors Help topic Reports > Performance Reports.
Forecast Splitting by Using Percentages

Users can specify a percentage to allocate volumes from a multi-site activity to
each Child (site) activity or apply a template. The interval can be the entire
forecast scenario, weekday, or timestep. [+]

See the Web for Supervisors Help topic Forecast > Forecast Scenarios >
Volume Split Wizard.

Forecast Staffing Totals Displayed in FTE or Man Hours

Forecast staffing totals are now displayed in the WFM interface and reports as
Forecast Total Equivalent (FTE) or man hours and are editable in both modes (in
views in which totals are editable). [+]

See the Web for Supervisors Help topics:

* Forecast > Graph View Options > Graph View Options Staffing

e Schedule > Schedule Scenarios > Scenario Summary View

e Schedule > Master Schedule Views > Master Schedule Summary View

¢ Schedule > Master Schedule Views > Master Schedule Overtime Requirements View
* Reports > Forecast Reports > Forecast Report and Forecast Graphs Report

e Reports > Performance Reports > Actual Overhead Report

e Reports > Schedule Reports > Schedule Summary Report, Weekly Schedule Coverage Report, and
Activity Weekly Schedule Report
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MSA Button Always On

Users can now set the Use Multi-Site Activities button to On in any view and it
will be set to On in all views, in which this button is available.[+]

See the following affected views in Web for Supervisors Help:

e Forecast Volume (Scenario and Master)

e Forecast Staffing (Scenario and Master)

e Forecast Graphs (Scenario and Master)

e Forecast Historical Data Views (Volumes and Graphs)

e Performance Intra-day View

e Performance Monitor

e Schedule Coverage (Scenario and Master)

¢ Schedule Intra-day, Performance (Scenario and Master)
e Schedule Summary (Scenario and Master)

e Schedule State Group Totals (Scenario and Master)

¢ Schedule Overtime Requirement (Master)

System Security: Last Log In Timestamp

To improve on system security, an enhancement enables the timestamp
information from the previous login to display in the GUI the next time a user
logs in to WFM Web through the Supervisor, Agent, or Agent Mobile interfaces,
alerting users of any unauthorized use of their login credentials. [+]

See the Web for Supervisors Help topic Getting Started > Logging In and the
Agent help topic Getting Started > Logging In.

New WFM Splash Screen
A new splash screen displays when WFM Web is loading the Log In GUI.
Page Limit for Reports

Two new options, PageLimit and PageLimitForCSV can be used to limit the size of generated
reports, controlling the maximum number of pages a report can contain and improving performance.

Objects and Functionality Moved

Some modules, configuration objects, and functionality that were previously in
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WFM Configuration Utility have been moved to WFM Web. [+]

See the following topics in the Web for Supervisors Help:

e Policies > Contracts

* Policies > Rotating Patterns

e Configuration > Agents > Activities

e Configuration > Agents > Contracts and Rotating Patterns

Localization Kits Include Context Information

WFM Localization kits now include context information for resources displayed in
the product that will be translated. [+]

See “Context Information in Localization Kits” on page 250.

Back to Top

New in 8.1.1

Automated Shrinkage Forecasting

Users can evaluate scheduled shrinkages (overheads) against forecasted
shrinkages and can create Overhead Forecast templates from the scheduled
overhead data. See more.. [+]

See the Web for Supervisors Help topic Schedule > Master Schedule Views >
Master Schedule State Group Totals > Actions menu/Toolbar buttons.

Selective Historical Forecasting

Users can specify unique, multiple periods of historical data during the forecast
build process to create forecasts that reflect seasonality. This ensures that
staffing needs are adequately met. [+]

See the Web for Supervisors Help topic Forecast > Forecast Scenarios >
Volumes Build Wizard > Select Historical Data.
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Schedule Audit and Rollback

WFM tracks which parameters were changed in a schedule, and provide an
option to go back to a previous schedule (before the change was made).[+]

See the Web for Supervisors Help topics:

e Reports > Audit Reports > Schedule Audit Report

e Schedule > Modify Individual Agents' Schedules > Modify Individual Agents' Schedules
Overview

e Schedule > Modify Individual Agents' Schedules > Schedule History
Schedules Display With Time Zone Adjustments

Intra-day Schedule View displays time zone offsets in schedules.[+]

See the Web for Supervisors Help topic Intra-day Schedule View.
Automated Time Off Wait List

WFM can automatically grant Time Off to requestors on the wait-list (based on
their position in the queue) and can automatically insert valid Time Off Requests
into the Master Schedule. Additionally, agents can now see their own position in
the queue.[+]

See the Web for Agents Help topics:

e Time Off > Requesting Time Off
e Time Off > Time Off > Recalling a Time Off Request
e Time Off > Deleting Time Off

See also, the Administrator's Guide sections:

 WFM Server Options, see the AutoPublishTimeOffToSchedule configuration option in the
CalendarService section

* Enabling and Configuring Wait-list Functionality

Exception Management

Users can select a specified item (such as an Exception) and find all items like it
for a selected agent or agents—and then make a bulk edit or change.[+]
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See the Web for Supervisors Help topic Schedule > Insert Multiple Wizard >
Select Exception Screen.

Microsoft SQL Database Replication

WFM now supports peer-to-peer transactional replication of all database tables
between all locations, which provides MS SQL database users with an alternative
to deploying terminal services when the server is not located near the
database.[+]

See MS SQL Database Replication.

Miscellaneous Modifications

You can click the Current Whole Day (Today) button to display data for the current day in the Master
Schedule Intra-Day view. [+]

See the Supervisor help topic: Schedule > Master Schedule Views > Master Schedule Intra-Day
View > Master Schedule Intra-Day View Overview.

e Government agencies and other corporations can now comply with Handicap Accessibility Regulations.
Accessibility for the blind, color blind, and users of limited mobility was improved to the WFM Web for
Supervisors module. [+]

See the Supervisor help topic About WFM Web.

* Employee ID was added to these reports: Schedule States, Individual Schedule, and Weekly Schedule.
[+]

See the Supervisor help topics Reports > Schedule Reports > Individual Schedule Report,
Schedule States Report, and Weekly Schedule Report.

* Platform support changes are detailed in the Genesys Supported Operating Environment Reference
Manual. Below is a summary:

* Discontinued OS support: IBM AIX 5.1 and 5.2, 32- and 64-bit versions.
* Added support of web browser Microsoft IE9.

* Terminal servers WFM DB and Config Utilities added support for Citrix XenApp version 6 (Platinum
Edition).

* WFM Web Server support limited to Red Hat Enterprise Linux, version 6 and IBM WebSphere
Application Server, version 8.

Back to Top
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New in 8.1

Shared Transport

WFM now supports the ability to group agents who share transportation (such as
carpools or service buses) by building schedules that allow these agents to start
and leave at the same time. Agents Supervisors, and Administrators can create
new shared transportation groups as well as joining or removing existing ones.
Supervisors and Administrators can also switch the scheduling of these groups
on and off during the schedule build process. See more.. [+]

For detailed information, see:

e Web for Agents Help topic Shared Transport

e Web for Supervisors Help topic Configuration > Configure Shared Transportation, Schedule >
Intra-Day Schedule Rebuild Wizard > Shared Transportation Constraints

» Configuration Utility Help topic Configuration > User Security > Security Options >
Configuration Security Options

« WFM Web Options, the AllowAccessToCarpools configuration option in the AgentSchedule section.

Simultaneous Scheduling of Deferred Work Activities

The forecasting algorithm for deferred work activities is enhanced so users can
optimize the way that Deferred Activities are processed at an interval level,
without impacting service levels for Immediate Activities. This facilitates the
user's ability to address unplanned staffing variances and make better use of the
available resources.[+]

For detailed information, see:

e Web for Supervisors Help topic Forecast > Forecast Scenarios, Staffing Build Wizard, and
Volumes Split Wizard

» Configuration Utility Help topic Configuration > Activities > Statistics Configuration for
Activities

E-mail Notifications Enhancements

WFM now provides a security option that controls which WFM Web Supervisor
receives e-mail notifications regarding an Agent's Time Off balance. These
notifications will be sent when a Time Off change is made in the calendar or
schedule.[+]
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For detailed information see the Configuration Utility Help topic Configuration
> User Security > Security Options > Notification Options

Build Schedule Scenarios based on Forecast Scenarios

Now you can build a “test” schedule based on a forecast scenario. [+]

For detailed information see the Web for Supervisors Help topic Schedule >
Schedule Scenarios > New Scenario Wizard

Working Rules/Scheduling Constraints

It is now possible to define in the Contract the maximum amount of Sundays that
can be worked at a given site. Users can select both the Minimum Duration
Between the Start Times of Two Consecutive Working Days and the
Minimum Duration Between the End of One Day and Start of Next
Working Day. [+]

For detailed information see the Configuration Utility Help topic Policies >
Contracts > Contracts Overview, Contract Constraints, Contract Weekend
Rules, and Contract Synchronization.

Print Schedule Without Relying on the Browser

Agents can print a schedule without relying on the print functionality of their
browsers. [+]

For detailed information see the Web for Agents Help topic Schedule > My
Schedule Tab Overview.

Estimate Time Off Limits Wizard

Time Off Limits will now take into account the total number of agents that may
take time off, along with the start/end of contract availability, the earliest stat/
end times of shifts assigned to the contract (including week days) and Activity
open hours for which the agent is skilled to work. These constraints optionally

include Rotating Patterns and Granted Calendar items. [+]

For detailed information see the WFM for Supervisors Help topic Calendar
Module > Time-0Off Limits > Set Time Off Limits Wizard.
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Accessibility

Enhancements to the WFM Web Agent and Supervisor interfaces allow corporations to comply with
Handicap Accessibility regulations. These include not using color to display statuses, tabulation
enhancements to provide focus to a visible control point, the ability to skip navigation links when
using a screen reader, allowing agents to change the visual representation of the OS, and ensuring
that all frames have titles.

Operating Systems Supported

* IBM AIX, 64-bit, version 7.1

e Microsoft Windows Server 2003, x64

* Microsoft Windows Server 2008 R2 Standard, x64
* Microsoft Windows 7, x32 and x64

e Support discontinued for Microsoft Windows Server 2000, x32
Databases Supported

e DB29.7
¢ Microsoft SQL Server 2008

System Platforms Supported

* Native support of 64-bit executables on MS Windows 2008 R2 for WFM Server, Builder, Daemon, Data
Aggregator

* VSphere 4 Hypervisor virtual platform
System Protocols

e Protocol IP v6 supported for WFM Server, Builder, Daemon, Data Aggregator, Database Utility,
Configuration Utility, and Web.

System Security(Radius meta-message display)

Application end users can now see any meta-text that is associated with successful authentication
attempts to a Radius server. Supported for Database Utility, Configuration Utility, and Web.

System. Secure Data Storage
e Encryption support for data stored in Oracle 11g or MS SQL Server 2008.
Secure Connections

e Secure communications (SSL/TLS) between all WFM components, and between WFM and Genesys
components. Supported for WFM Server, Builder, Daemon, DA, DBU, CU, and Web.
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For a complete list of all databases and operating systems supported by Genesys, see the Genesys
Supported Operating Environment Reference Manual.

Back to Top
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